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1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and
skills:

• Knowledge of the robot controller system
• Basic knowledge of the Windows operating system
• Basic knowledge of network technology

For optimal use of KUKA products, we recommend the training courses
offered by KUKA College. Information about the training program can be
found at www.kuka.com or can be obtained directly from our subsidia-
ries.

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

• Documentation for the robot arm
• Documentation for the robot controller
• Documentation for the smartPAD-2 (if used)
• Operating and programming instructions for the System Software
• Instructions for options and accessories
• Spare parts overview in KUKA Xpert

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety

These warnings are provided for safety purposes and must be observed.

DANGER
These warnings mean that it is certain or highly probable that death or
severe injuries will occur, if no precautions are taken.

WARNING
These warnings mean that death or severe injuries may occur, if no
precautions are taken.

CAUTION
These warnings mean that minor injuries may occur, if no precautions
are taken.

NOTICE
These warnings mean that damage to property may occur, if no precau-
tions are taken.
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These warnings contain references to safety-relevant information or gen-
eral safety measures.
These warnings do not refer to individual hazards or individual precau-
tionary measures.

This warning draws attention to procedures which serve to prevent or rem-
edy emergencies or malfunctions:

SAFETY INSTRUCTION
The following procedure must be followed exactly!

Procedures marked with this warning must be followed exactly.

Notices

These notices serve to make your work easier or contain references to
further information.

Tip to make your work easier or reference to further information.

1.4 Terms used

Term Description

KLI KUKA Line Interface
Ethernet interface of the robot controller for external communication

KRL KUKA Robot Language
KUKA robot programming language

KSS KUKA System Software

KUKA smartPAD see “smartPAD”

KUKA smartPAD-2 see “smartPAD”

RoboTeam Continuous path motions of RoboTeam participants which are
synchronized and/or geometrically coordinated.

RoboTeam participant Participant in a RoboTeam. A participant can be a robot, a turn-tilt
table or a rotational axis.

smartHMI smart Human-Machine Interface
User interface on the smartPAD

smartPAD Programming device for the robot controller

The smartPAD has all the operator control and display functions re-
quired for operating and programming the industrial robot. 2 models
exist:

• smartPAD
• smartPAD-2

In turn, for each model there are variants, e.g. with different lengths
of connecting cables.

The designation “KUKA smartPAD” or “smartPAD” refers to both
models unless an explicit distinction is made.

VRP Virtual Remote Pendant
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VSS VW System Software

1.5 Trademarks

Windows is a trademark of Microsoft Corporation.
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2 Product description

2.1 Product description

Description

The KUKA.VirtualRemotePendant 1.2 option package is a virtual KUKA
smartPAD which can be used to access any robot controller that has a
network connection via the KLI. Unlike with the real KUKA smartPAD, jog-
ging the robot does not require enabling with the enabling switch.

Functions

• The same functions as a real KUKA smartPAD with the following limi-
tations:

‒ The robot can be moved under manual or program control only
under the following conditions:

‒ The robot controller is operated in AUT EXT mode before the
connection is established.

‒ The safety gate is closed and acknowledged.
‒ It is not possible to switch to CRR (Controlled Robot Retraction)

mode.
‒ The test operating modes T1 and T2 that can be selected with

KUKA.VirtualRemotePendant do not correspond to the operating
modes in the standard EN ISO 10218-1, but are equivalent in
terms of the safety level.

‒ It is not possible to archive data from robot controllers to the PC/
laptop on which KUKA.VirtualRemotePendant is installed.

‒ Manual manipulation of digital or analog outputs is only possible
with the safety gate closed and acknowledged.

‒ It is not possible to operate a RoboTeam with KUKA.VirtualRemo-
tePendant.

2.2 Intended use and misuse

Use

KUKA.VirtualRemotePendant 1.2 is intended for operating a robot system
via the KLI interface instead of using the KUKA smartPAD for this pur-
pose.
KUKA.VirtualRemotePendant 1.2 may only be installed on a PC that
meets the specified system requirements. This PC must not be a robot
controller. Within reach of the PC there must be a functioning EMERGEN-
CY STOP device that acts on the robot system to be operated.

Misuse

Any use or application deviating from the intended use is deemed to be
misuse and is not allowed. KUKA Deutschland GmbH accepts no liability
for damage or injury caused thereby. The risk lies entirely with the user.
Examples of such misuse include:

• Using KUKA.VirtualRemotePendant to operate a robot system that is
outside the user’s field of vision

• Operating a robot system with KUKA.VirtualRemotePendant without an
active EMERGENCY STOP device within the user’s reach
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3 Safety

This documentation contains safety instructions which refer specifically to
the option package described here.
The fundamental safety information for the industrial robot can be found in
the “Safety” chapter of the Operating and Programming Instructions for
System Integrators or the Operating and Programming Instructions for End
Users.

Comply with safety-relevant information
The safe use of this product requires knowledge of and compliance with
fundamental safety measures. Death, severe injuries or damage to prop-
erty may otherwise result.
• The “Safety” chapter in the operating and programming instructions

of the system software must be observed.

WARNING
The safety measures for the KUKA smartPAD, described in the “Safety”
chapter of the Operating and Programming Instructions of the System
Software, also apply for KUKA.VirtualRemotePendant and must be ob-
served accordingly. Death to persons, severe injuries or considerable
damage to property may otherwise result.
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4 Planning

4.1 EMERGENCY STOP device

The system integrator is responsible for ensuring that an EMERGENCY
STOP device is installed at each remote operating station. This EMER-
GENCY STOP device must act on the EMERGENCY STOP circuits
whose robots and robot systems can be operated from the respective re-
mote operating stations. A remote operating station is a laptop or PC on
which KUKA.VirtualRemotePendant is installed and which is connected to
robot controllers via KLI.
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5 Installation

5.1 System requirements

Hardware

• KR C4 or KR C5 robot controller

Software

Laptop/PC:

• Windows 7 or Windows 10 (32-bit or 64-bit)
• Graphics card with a resolution of at least 1024 x 768 pixels

Robot controller:

• KUKA System Software 8.2.x, 8.3.x, 8.6.x or 8.7.x
• Or VW System Software 8.2.x, 8.3.x, 8.6.x or 8.7.x

The numbers of the required releases must be taken from the file Relea-
seNotes.txt. The file is located on the data storage medium containing KU-
KA.VirtualRemotePendant 1.2.

5.2 Installing KUKA.VirtualRemotePendant

KUKA.VirtualRemotePendant must not be installed on a robot controller,
Office PC or OfficeLite virtual machine.

Precondition

• Local administrator rights

Procedure

1. Start the program Setup.exe from the CD-ROM.
2. Select the desired language and click on Next >.
3. The installation wizard opens. Click on Next >.
4. Accept the license agreement and click on Next >.
5. Read and accept the safety instruction and click on Next >.
6. Select the directory and click on Next >.
7. Click on Install. KUKA.VirtualRemotePendant is installed.
8. Once installation is completed, click on Finish to close the installation

wizard.
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6 Graphical user interface

6.1 KUKA.VirtualRemotePendant user interface

The KUKA.VirtualRemotePendant user interface largely corresponds to the
smartHMI. Here, only those parts of the user interface are described that
are specific to KUKA.VirtualRemotePendant.
If a touch screen is used, the user interface can also be operated with a
finger or stylus.

Information on the smartHMI can be found in the operating and pro-
gramming instructions for the System Software.

Fig. 6-1: KUKA.VirtualRemotePendant user interface

1 Session Manager 2 Virtual KUKA smartPAD

Fig. 6-2: Session Manager
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Item Description

1 Group

2 Robot name or IP address

3 Connect button

4 Status indicator (corresponds to the display on the smartHMI)

5 On button

Button Description

The VRP is connected to the controller.

The VRP is establishing a connection to the controller.

An error occurred while establishing a connection.

A smartPAD is connected to the controller.

The controller is switched off or cannot be accessed.

No smartPAD is connected to the controller. The VRP can
be connected to the controller.

The controller is switched off or cannot be accessed.

The controller has been shut down, but not switched off at
the main switch. The button can be used to switch the con-
troller on.

The controller is switched on or cannot be accessed.

KUKA.VirtualRemotePendant 1.2
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7 Operation

7.1 Starting KUKA.VirtualRemotePendant

Precondition

• KUKA.VirtualRemotePendant is installed.

Procedure

• Double-click on the KUKA Virtual Remote Pendant icon on the desk-
top.
Or: Select All Programs > KUKA > KUKA Virtual Remote Pendant
in the Windows Start menu.

The first time the program is started, the Select controllers window is
opened.

7.2 Selecting a robot controller

Description

A robot controller can only be accessed if it has been selected and added
to the Session Manager. A robot controller can be selected either manual-
ly or using the network search.

Precondition

• Robot controllers are connected to the company network via KLI.
• Laptop or PC is connected to the desired robot controller via the net-

work.
• KUKA.VirtualRemotePendant has been started.

Procedure for network search

1. Select the menu sequence Edit > Select controllers. A window for
selecting the robot controllers is opened.
All robot controllers present in the network are automatically displayed
on the Network search tab.

2. To display suitable robot controllers only, activate the Show only suit-
able controllers check box.

3. Select the desired robot controller and click on the Right arrow but-
ton.

4. The selected robot controller is displayed in the right-hand window.
Click on OK. The robot controller is displayed in the Session Manager.

Procedure for manual entry

1. Select the menu sequence Edit > Select controllers. A window for
selecting the robot controllers is opened.

2. On the Manual input tab, enter the IP address or name of the control-
ler in the input box.

3. Click on the Right arrow button.
4. The selected robot controller is displayed in the right-hand window.

Click on OK. The robot controller is displayed in the Session Manager.

KUKA.VirtualRemotePendant 1.2
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Fig. 7-1: Window for selecting the robot controllers

7.3 Creating and deleting groups

Description

It is possible to create groups in KUKA.VirtualRemotePendant. Groups
can be used to gain a clear overview of the robot controllers, e.g. by
grouping together the robot controllers of a cell. A maximum of 5 groups
can be created.

Precondition

• KUKA.VirtualRemotePendant has been started.

Procedure

1. Select the menu sequence Edit > Select controllers. A window for
selecting the robot controllers is opened. Group A is already created
by default on the right-hand side of the window.

2. Click on New group. A new tab is created on the right-hand side of
the window.

3. Optional: use drag&drop or the Up arrow and Down arrow buttons to
change the order of the robot controllers in the group.

4. To delete a group, select the group and click on Remove group.
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Fig. 7-2: Window for selecting the robot controllers

7.4 Connecting KUKA.VirtualRemotePendant to a robot controller

Description

To access a robot controller, a connection to this controller must be estab-
lished via the Session Manager.

In T1, T2 and AUT modes, a connection is only possible if no
smartPAD is logged onto the robot controller. The robot cannot be
moved in these operating modes. Operator actions that do not require
motion enabling can be executed, however. AUT mode is not relevant
for the VSS.

Precondition

• The robot controller is switched on and accessible via the network.
• AUT EXT mode
• Safety gate is closed.
• KUKA.VirtualRemotePendant has been started.
• The robot controller is selected and is displayed in the Session Man-

ager.

Procedure

1. Click on the  button for the desired robot controller in the Session
Manager. The connection is established.

2. To terminate the connection, click on the button again or exit KU-
KA.VirtualRemotePendant.

KUKA.VirtualRemotePendant 1.2
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Session Manager

Fig. 7-3: Session Manager

Item Description

1 Group

2 Robot name or IP address

3 Connect button

4 Status indicator (corresponds to the display on the smartHMI)

5 On button

Button Description

The VRP is connected to the controller.

The VRP is establishing a connection to the controller.

An error occurred while establishing a connection.

A smartPAD is connected to the controller.

The controller is switched off or cannot be accessed.

No smartPAD is connected to the controller. The VRP can
be connected to the controller.

The controller is switched off or cannot be accessed.

The controller has been shut down, but not switched off at
the main switch. The button can be used to switch the con-
troller on.

The controller is switched on or cannot be accessed.
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7.5 Exiting KUKA.VirtualRemotePendant

If the robot controller is in T1, T2 or AUT mode and VirtualRemotePend-
ant is exited, the PLC can no longer control the robot. It is advisable to
switch to AUT EXT mode before exiting KUKA.VirtualRemotePendant.
AUT mode is not relevant for the VSS.

Precondition

• KUKA.VirtualRemotePendant has been started.

Procedure

• Select the menu sequence File > Exit.
KUKA.VirtualRemotePendant is exited. If a connection to a robot con-
troller exists, it will be terminated.
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8 Troubleshooting

Error Cause Remedy

The robot cannot be moved
although the safety gate is
closed and acknowledged.

Before the connection to the
VRP was established, the ro-
bot controller was in T1, T2
or AUT mode. AUT mode is
not relevant for the VSS.

1. Terminate the VRP con-
nection.

2. Set the operating mode to
AUT EXT on the robot
controller.

3. Re-establish the VRP
connection.

After the VRP has been exi-
ted, the robot can no longer
be controlled by the PLC.
The following message is dis-
played:

“Virtual KCP was not discon-
nected in EXT mode.”

Before the VRP was exited,
the operating mode was set
to T1, T2 or AUT. AUT mode
is not relevant for the VSS.

1. Connect the VRP or
smartPAD to the robot
controller.

2. Acknowledge the mes-
sage.

3. Set the operating mode to
AUT EXT.

VRP connection was termina-
ted automatically.

A smartPAD was connected
to the robot controller.

• The controller is in AUT
EXT mode: re-establish
the connection.

• The controller is in a dif-
ferent operating mode: re-
connection is not possible
as long as the smartPAD
is connected.

A different VRP has been
connected to the robot con-
troller.

Re-establish the connection.

The maximum number of
connections has been excee-
ded; the connection was the
oldest connection.

Re-establish the connection.

Note: If the maximum num-
ber of connections is excee-
ded again by the re-establish-
ed connection, the oldest
connection is terminated.

The robot controller has been
switched off.

Switch the robot controller
back on.

8.1 Saving the LOG file

Description

Information about the status of the application and any errors that have
occurred is saved in the LOG file of KUKA.VirtualRemotePendant. In the
case of an error, the user can send the LOG file to KUKA Service.

Precondition

• KUKA.VirtualRemotePendant has been started.

Procedure

1. Select the menu sequence ? > Error treatment. A window opens.
2. Select the directory in which the LOG file is to be saved.
3. Click on Save.
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If the application no longer responds, the file VirtualRemotePendant.log
can be copied from the directory %APPDATA%\KUKA\VRP.
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9 KUKA Service

9.1 Requesting support

Introduction

This documentation provides information on operation and operator con-
trol, and provides assistance with troubleshooting. For further assistance,
please contact your local KUKA subsidiary.

Information

The following information is required for processing a support re-
quest:

• Description of the problem, including information about the duration
and frequency of the fault

• As comprehensive information as possible about the hardware and
software components of the overall system
The following list gives an indication of the information which is rele-
vant in many cases:

‒ Model and serial number of the kinematic system, e.g. the manip-
ulator

‒ Model and serial number of the controller
‒ Model and serial number of the energy supply system
‒ Designation and version of the system software
‒ Designations and versions of other software components or modifi-

cations
‒ Diagnostic package KRCDiag

Additionally for KUKA Sunrise: existing projects including applica-
tions
For versions of KUKA System Software older than V8: archive of
the software (KRCDiag is not yet available here.)

‒ Application used
‒ External axes used

9.2 KUKA Customer Support

The contact details of the local subsidiaries can be found at:
www.kuka.com/customer-service-contacts
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